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Turning on your computer

If your computer keyboard looks like this, you are using a Power Mac G3 computer:

Push the circled Start-up key in the upper right corner of the keyboard.  You should hear a
chime, and your computer will start up.

If your computer looks like this, you are using an iMac computer:

Push the Start Button on the front of your machine.  You should hear a chime, then your machine
will start up.



Navigating the Mt. Washington School Computer System

The Macintosh Manager Interface – Login Screen

This is what you see first after turning on your computer.

Click in the first white box

Where it says Name, type _________________________

Click in the second white box

Where it says Password, type ________________________
This is your login password.  It only works to get you into our school Macintosh Manager
Server.  If you write it down to remember it, please be sure to put that piece of paper in a secure
place where students will not find it.  If you write it in the space above, keep this manual in a
secure place.

Press Return or click the Log in button

Note that this is where the Shutdown button is.  Use it at the end of the day when you have
finished saving any documents you were working on.



In the Green Teacher Panel you see the icons and the names of the applications that are
available for you to use.

1.  Acrobat Reader lets you read certain documents found on the Internet and in Classworks
Gold.

2. Appleworks does wordprocessing, spreadsheets, database, and picture files.
3. CardShop Plus is an easy way to make greeting cards and 8 x 10 posters.
4. Claris Home Page makes web pages you can post on the Internet.
5. Classworks Gold has many programs that students and teachers can use to reinforce

classroom learning.  You should see me about using it as it needs a teacher password.
6. The Control Strip allows you to adjust your screen’s size and colors, and your computer’s

volume.
7. Easy Grade Pro is a terrific program for keeping things like grades, attendance, seating

charts and much, much more.  It has excellent online help for learning how to use it.
Highly recommended.  Accepts Easy Grade files from your PC at home.

8. HyperStudio allows you or your students to create presentation projects.
9. iMovie will work if you have iMacs in your room.
10. Internet Explorer is our Internet Browser.   Use it for “surfing”  the web and to get your

email.
11. Kid Pix is a drawing and painting program for kids, but teachers can use it to make

assignments for classroom projects and simple signs.  Easy to use and fun.
12. Microsoft Excel is a spreadsheet application.  It can be used for grades with practice.



13. Microsoft Power Point is presentation software.
14. Microsoft Word is word processing.  You can use files saved on your PC at home with it.
15. The Teacher Work folder is for saving files if and/or when you get disconnected from the

main server.
16. Word Search allows you to create your own word searches for students.
17. The World Book icon should take you to the CD’s containing the encyclopedia.

Click once on an icon to get the program to run.

Please be sure to let me know if you have an application on your panel that will not run.

Students see the same kinds of panels when they login to the computers, but some of the
applications they see are different from yours.  Different grade levels have different applications.
They are kept separately to minimize confusion.  It is a good idea to monitor your students to see
what choices they have and to make sure they are using their machines responsibly.



The Blue panel with your name on it contains all the files you save and the Group and Shared
Documents Folders.

 One click will open any of these files or folders.  Use the scrollbar on the right to scroll down so
you can see the rest of your files.

If you click and hold your mouse button down on the File menu at the very top of the screen, you
can check the kinds of choices you have for doing things with your files and folders.



Your blue panel will not look exactly like this one. All the files and folders you see listed here
are saved on the main server, and your files will have different names. (Remember, there are 2
servers serving the 2 floors of the building.  What is available to you on one server may not be
available on the other.)

You can change the way the files are listed by using one of the options in the View menu at the
top of your screen.  Click and hold your mouse button to see the options.

 You can use the large icons like the ones above, smaller ones, or very small ones if you choose
to view as list.  If you have saved a lot of files, List View makes it easier to see what’s in your
folder.  The picture of the Shared Documents Folder on the next page shows what List View
looks like.

To return to your Green Panel, just click where your name is and the blue panel will drop down
to the bottom of the screen.  Click your name to access.



The Shared Documents Folder
contains all sorts of useful templates and
clip art for programs like AppleWorks
(ClarisWorks), HyperStudio, and
Microsoft Word, etc.  Open each folder
by clicking on it once.  Some clip art can
be used in more than one application.
You will need to do some experimenting
to see what works for you.

Any folder that begins with HS is to be
used with HyperStudio.

The Elab Files are math files for 3rd

Grade.  They work with the Elab
program the kids can access.

The Kid Pix Items folder contains
Backgrounds for use with Kid Pix, and
should work with other programs as
well.

Most of the other folders here are self-
explanatory.  If you get confused, come
and ask me.



 The Templates Folder

contains templates for Microsoft
Applications only.  They are standard
file templates that can help with forms
(Word), presentations (PowerPoint),
spreadsheets (Excel), and web pages.  (A
Word document can be saved as a web
page.  Choose Save as… from the File
Menu in Word.)

The IEP Templates are out of date.
There is a web site where you need to
get these now.  See me for more
information



Changing Your Login Password

You can change your password at the login screen.  It is a good idea to do this because
students can discover the standard password I give out, and other people can read, copy,
or delete your files.  You do not want this to happen.

At the login screen, type your name only

Notice that the Change Password button is no longer greyed out.  Click there.

The next window you see is on the next page.



On the top line, type the password I gave you.

Type your new password in the next 2 lines, once on each line.  It should be at least 4
characters.  You can use letters or numbers, but letters and numbers together is the most
secure.  A nonsense word also works well as does the name of a family member whom no
one has met.  Just be sure that it is something that you will remember, and write it down
in a secure location.

When you have finished typing the Verify line, click the OK button.  That’s all there is to
it.  Easy!  You are in charge!

Security hint.  Do not leave open documents on your screen during class times.  Save,
quit, and logout.



Using a floppy disk

When you insert a floppy disk into your machine it makes a new panel.  Looking at the
panels, the color is different from the color of your main panel or your Documents panel,
but otherwise it looks pretty much the same.  The view can be changed in the same ways
it can be changed for the other panels. (See below.)  List view is convenient if there are
many files.  What you see below is List View for both my Documents folder and my
floppy disk.

You can copy files from your floppy to your Documents folder, and from your
Documents folder to your floppy.  It is important to keep in mind that a floppy disk is not
a reliable place to keep important files.  You are unlikely to lose files saved on the server
which is backed up regularly, but a floppy disk can be easily damaged.  All it takes is a
bit of dust or a finger print in the wrong place, and your entire disk becomes unreadable.
If you need to carry your grade book files home to work on them, be sure to copy them
back to the server the next day.  These are files you do not want to have to recreate.

The lavender panel on the right is the panel for your floppy disk.  Notice the icon in the white

box at the top of this panel.



Copying files from a Floppy Disk to a Documents Folder

First, make sure you can see the scrollbars in the Lavender panel. If they are not
showing, click the side or the bottom of the panel to make them appear.  Open the File
menu.  Hold your mouse button down, and go to the bottom to the word Copy…  Let go
of your mouse button.  You will now see the Copy Window:



Make sure you see your name after the word “To”  in the popup menu.  Notice it already
says “your documents folder” underneath.  Do Not choose Other from the popup menu.

Select the file you want to copy by clicking on it.  Now all you have to do is click OK,
and your file will be copied from your floppy disk to your Documents Folder on the
server.  Easy, right?

You will see the “Copy to …….”  window on your screen:

Copy files from your Documents Folder to your floppy disk.

This is much the same as copying from the floppy.  See the next page.



First,  make sure the scrollbars are showing in your Blue Documents Panel.

Locate the file you want to copy using the scroll bars in your blue panel.  Go the File
menu and select Copy as you did before.  The copy window will appear again.

The name of your floppy disk (Millard, here) should show in the popup menu after the
word “To:”.  You should see a Disk icon underneath and some information about how
much space you need and how much is available.  Select the File you want to copy.  Once
again, click the OK button, and the “Copy to” window will appear.

Practice is important when doing this, but don’t worry too much about making mistakes.
As long as you remember the name of your file, I can find it on the server no matter
where you may have saved it.  Take your time.  And remember that one of my jobs is to
help you out when you’re having problems.



Selecting a Printer and Printing a Document.

Imagine that you’ve spent an hour creating a test you need tomorrow.  You go to the File
menu to Print, and you wait for the magic.  But nothing happens!  Or you get a message
on your screen that says “No Printer has been selected in the Chooser”, and you can’t
print.  Do this first:

At the top left of your screen is a tiny picture of an apple.  This is called the Apple
Menu.  Point your mouse there and hold the button down.  You should see this:

Move the mouse pointer down to the Chooser and let go.  This brings up the Chooser
Window.

Click first on the icon of the printer you have.  This will most likely be the DW 600
Series (AT).  If you look at the front of your printer, you should see the words Deskwriter
694C or something similar.  Underneath “Select a DeskWriter” you should see a list of
printers.  The printer that has your room number is the one you select.  That’s all you
need to do.



Don’t click anywhere else in this window!  Close it by clicking the Close
Box

If you forget and click the other little box up there on the right, don’t worry, just click it
again, and the box will appear again.  (This is called the Window Shade Box.)

If you do not see your printer in the window, do not select another one unless you are
desperate to print, and you know the other teacher will not mind.  Instead, try this:

Make sure your printer is on.  If it is not on, turn it on by pressing the button.  Close the
Chooser.  Wait a few moments and open the Chooser again.  If you still do not see your
printer in the list, close the Chooser, turn your printer off, then on, and try the Chooser
one more time.  If you still don’t see your printer, send for me.  It’s usually a quick fix.

Note on Printing  :

Paper.  Use plain paper only.  Copier paper works fine.  Do not use heavy weight papers
or Construction paper.  Printer repairs take forever (sometimes years), so take care of
your machines.

Ink:  You need to supply your own ink cartridges.  You can order them with your other
classroom supplies.  Jean has the numbers to order or you can copy the numbers off the
empty ones.  You need two cartridges, one for black ink, and one for color.  If you want
to print photos, there is a color photo ink cartridge in the little grey box near your printer
for printing on photo paper.  If you no longer have one, see me.

General Machine Care:

Try to keep your machines, mice  and the area around them clean and free of papers,
books, pencils, liquids, etc.  Windex sprayed on a paper towel (not on the machine or its
parts) will clean screens, keyboards and mice.  A soft 1” paintbrush is useful for dusting
keyboards.  The custodial staff is not supposed to touch the computers or tables.

If you accidentally press the start key while cleaning, just let the machine start up and
then shut it down again.  Cleaning is best done when the machines are off.

Don’t make computer cleaning a regular, rotating classroom chore for students.



The Internet

In the Green Panel, click on

It will take you directly to our school homepage, which looks like the picture below.
There is a lot of useful information here that you can use.  Some is on the right side, and
some on the left.  Take the time to explore.

To access the District Email  system, click on the Teacher Email link on the right side of

our home page.  When you are looking at web pages on the internet, words that are
underlined are usually links to other pages.  Clicking your mouse once on a link should
take you to the page you want.

You should now see the District GroupWise Web Access page. (Next Page)



Click in the Name box and type your email user name which you should have received
from me.  This is usually a 7 character name made from the first 6 letters of your last
name and the first initial of your first name.  Then click in the password box and type
your password.  If you have never used the mail system before your password will be
“password” (without the quotation marks).  Once you have logged in successfully, you
should change your email password.  See the next page for details.



You can change your password by clicking on the Options link on the email page:  If you
do not see it, scroll down until you can.

.

Near the top of the page
there are also buttons
which will help you delete
or move your mail around.

The File icon with the
pencil is one way to start a
new message.  Click on
the picture

The rollodex icon is a
good place to look for
CPS email addresses.
Click on the icon, then
type in a name.

Be sure to logout when
your have finished reading
your mail.  Click on the
door.

More help is available
from the Help link.

In the white part there are
more icons.  Here, you
must click on the lines
under the words to select
an item.



The right side of your screen will look something like the above.  Each little envelope is a
message.  To read the message, click on the underlined words.  To delete messages, click
the boxes to the left of the envelopes.  Then click the Delete button at the top.

To reply to a message, click the “Reply to Sender” link at the top of the Message screen.



This is where you type your reply to the person who sent you the message.  Click the
“Send” button to send your message.

 Click the “Address Book” button above to search for another address.  Type in a last
name and click the “Search” button.

  To come back to your message click the “Cancel” button under the place where it says
System Address Book.



More mail help is available at http://StaffNet.cps-k12.org/.  This site is only available
from school, not from your home.

Homeroom.com

Homeroom.com is online practice for students for the Ohio Proficiency Tests at all
levels.  Teachers need to use the site to set up tests for their students and to track their
progress.  The link to Homeroom.com is on our homepage near the bottom of the right
side.  Click to access.

All you have to do is click once on the link.  It will take you directly to the
Homeroom.com home page.



Look at the top right corner of the page.  You will need to click on the Sign in link to sign
in.  If you do not see the link do this:

Go to the most top right corner of your screen.  Hold your mouse button down on the
blue E.  You will see the word Panels.  Holding your mouse, slide down to Panels and let
go.

This takes you back to the Green Panel.

Click on the Control Strip.  A window will open that looks like this:



Click the Show Control Strip button, and then close the window from the upper left
corner.  You do not need to change anything else here.



The Control Strip should appear somewhere below on the left side of your screen.  You
may have to click on the end to stretch it out.

.
Click on the Monitor icon that has the square around it.  Hold your mouse button down.
Change the monitor setting to  “800 x 600”.  Close your Control Strip by clicking on the

end.  That will get it out of the way.

  Go back to that upper right corner of the menu bar where the word “Panels” is.  Hold
your mouse button down, and pull down to the E for Explorer.  You can drag the bottom
right corner of Explorer now to fill your screen, and you should be able to see the words

“Sign In”.



Click on “Sign In”.  The next screen will eventually come up.

Click where it says Username and type the user name for Homeroom.com that you
received from me.  You can use the TAB key to get to the next box.  In the 2nd box type

the password I gave you.  If all goes well, you should see the following screen next.



Use the Online Training link for further help in setting up your classes.  Your students
should already have usernames and passwords.  See me if you need a list.

Notes on Passwords

There are 4 names and passwords to keep track of:

1. Your Macintosh Manager login
On the 1st floor this is your last name (except gym and DI)
On the 2nd floor this is your first and last name.

   Your Macintosh Manager password.

2. Your email name and password.
3. Your Homeroom.com user name and password.
4.  Your Classworks Gold name and password.

If you write these down and keep them in a safe place, you’ll be able to find them when
you need them.  You can also choose to have all the passwords be the same which may
make them easier to remember. Do not leave passwords where students may find
them, and never give a student your password.



Classworks Gold

Classworks  Gold is available to teachers of grades 1-6.  It is a very valuable resource for
integrating technology into your classroom.  It is really many different educational
programs for students put together in a way that follows a sequence by grade level.
Students can practice reading, language and math skills by following the sequence for
their grade level, or whatever level you decide to assign to them.  Each student signs in to
Class Works Gold with his/her first name and a number which they either know from
previous years or from the class roster sheet which you get from me.

You, as the teacher, also have a login for Classworks Gold, and a simple password.
There is also a manual available for it.  If you do not already have one, please see me.
Your login is both your first and last names.

There are 4 choices on this page, Student, Teacher, Exit, and Office.  They are self-
explanatory, except for Office, which is the part I use to enter all the names and do the
initial set up of classes. Click on the Teacher Desk.



Once you have entered your name and password, click the OK button.  A screen like the
one on the next page should come up.  Your class will not look like this one.



On the left is the list of students enrolled in this class.  On the right is the Assignment
Sequence.  At the top is a popup menu where you can change from Math to Reading and
Language classes.  There are also buttons you can click that show different kinds of
information for Assignments or for Students.

Classworks Gold tracks and scores all the student assignments, so you can see your
students’ progress in the Student Info screen.

At the very top, there is a Teacher Utility that will let you print out reports among other
things.  Use the File Menu to quit when you are finished working.

Now is the time to find that Glassworks Gold manual, or to come get one from me if you
do not have one in your room.  You will find that Classworks Gold is very flexible.  If an
activity is too easy or difficult or not right for your students, it can be skipped.  You can
preview every lesson your students will do before they do it.  So you can make the CWG
sequence align with what you are doing in your classroom.  There are Projects that you
can assign.  The time you spend learning it will be well worth it.

At the beginning of the year, I set up the class rosters and sequences.  You should not
accept these as what your students should be doing.  I’m not in your classroom, and I am
not familiar with the sequences you follow in your teaching.



Hints and Tips

Login tips.

All classroom computers are Apple Macintosh Computers.  All Mac computers (115) in
the building are networked.  That means that when you log in typing your name and
password, you are sending a message to one of the Macintosh server machines to let you
use the machine and it’s software.  The main servers are in the computer lab (109).
When classes are using the lab, as many as 32 people plus anyone in any classroom may
be trying to login at the same time.  It can seem to be a slow process,

The servers keep a databases of everyone’s name and password.  The machine that serves
the first floor classrooms is still subject to crashing when someone becomes impatient
with login speed at one machine and moves to login at a second machine with the same
name and password.  The server, trying to resolve the first login, sees the second one as
an error and freezes or crashes.  Unfortunately, the user doesn’t get an error message.
Machines freeze all over the first floor, and everyone using that server is thrown off.  It
can take as little as 15 or as long as an hour to get the server restarted, up and running.
Eventually, this server machine will be replaced.

Every server crash does damage to the databases that are on it: Login databases, Failure
Free Reading data bases, Classworks Gold databases, and Star Reading databases. Each
of 2 large hard drives can take up to 4-5 hours to repair.  Complete restoration of server
software and databases takes a whole day, even with backups.

So, when you or your students are sitting there, twiddling your thumbs waiting to get
logged in, or getting frustrated because a password does not seem to work, please resist
the temptation to log in at a different machine !!!!!  Make sure your kids resist it too.

If it’s a password problem, put a note in my box with the student’s name, and I will fix it,
and let you know what the password is.  The standard password for students in grades 3
and above is “Student”.  You might post a sign with this word on it somewhere near your
computers.

Any help you can give me like a sign over the computers and verbal reminders to kids
will be much appreciated.

Useful Keyboard Keys

There are keyboard shortcuts to most of the menu commands you see on your Mac.
On the bottom row of keys you will find 2 sets of these three keys





Please note:

Work unsaved before a server crash will be lost.  SAVE OFTEN!

Student Passwords and ID numbers

All students except Kindergarten and First Grade have passwords. Second graders have a
“homeroom password”.  (Each room has a different four letter password). All other
students have unique passwords that they have made themselves, or the standard
password I gave them, “Student”.   If kids forget passwords and mistype them 8 times or
more, their login becomes disabled, and a message appears that tells them to see their
Administrator.  Again, moving to another machine will not solve the problem.  They
have to see me.

Kids also sometimes learn another student’s password and try to login as the other
person.  This will cause a server crash if the other student is also logged in somewhere
else in the building, and at the very least, someone’s files could be damaged or deleted.
Please discourage kids from using someone else’s password or sharing their
passwords with friends.  If I know about it, I may disable both logins until I’ve talked to
them.

If kids learn another kid’s Classworks Gold ID number, they will also try that number
themselves.  They have been told that Classworks Gold tracks progress and that using
someone else’s number is doing that student’s work, but they forget.  Please reinforce
using only their own name and number when in Classworks Gold.  What seems like fun
at the time can make a big mess of the reports I give you at the end of each quarter.

Students and the Internet

Student Internet (Grades 3-8) use is always disabled at the beginning of the year.  An
Acceptable Use Policy (AUP) form must be filled out and returned before a student goes
on the Internet.  The returned AUP’s are kept in a student’s CUM, so they should only
have to be filled out once (until they are revised).  Students new to the district must take
one home for signing.  Send me a list of those students in your classroom who have
turned in forms.  K-2 kids probably do not need to have these forms signed.

Check with me before assigning a research project that involves the Internet.

If you have any other questions about applications or other problems with computers,

please do not hesitate to ask.


